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Chapter 8: Create and Edit Text 
Overview 
Illustrator provides an elaborate set of features that give you incredible control over the appearance of 
type. You can shape text along a path, package it inside an object, align text vertically (instead of the 
usual left to right), and generally cast text like molten metal to flow into your illustration. 

Illustrator CS integrates several helpful new features for managing type. Most dramatic is the ability to 
easily access thousands of characters from a single set of extended fonts called OpenType fonts. In 
addition, Illustrator CS supports type and paragraph styles (explored in Chapter 9) that allow you to save 
and apply sets of formatting features to selected text or paragraphs. 

Other Illustrator tools allow it to function as a scaled-down word processing utility, letting you perform 
basic editing, formatting, and even spell checking on your text. 

On the downside, the folks at Adobe have been careful not to copy and paste too many text formatting 
features from their InDesign desktop publishing program. If you want to design and lay out a multipage 
brochure, or access relatively basic features such as easy drop-cap formatting, you’ll bump up against 
the limits of Illustrator.  

 

 
Create Text 
To start creating text in Illustrator, select the Type tool in the Toolbox and start typing. As you do, the 
cursor displays as an I-beam text cursor. A vertical line that is larger (its size depends on text size) 
indicates where the insertion point is set, as shown in Figure 8-1.
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Figure 8-1: Creating text in Illustrator  

If you want to constrain your text within a set width and height as you type, select the Type tool and 
draw a text box first. Then click inside the text box (with the Type tool still selected) and type. Lines of 
text will wrap at the edge of the defined Type text box, as shown in Figure 8-2. 

  
Figure 8-2: Creating text constrained by a predefined text box  

As you type, you can change the location of the insertion point by pointing and clicking with your 
mouse or by using keyboard cursor movement keys. Some standard word processing rules apply in 
Illustrator: END moves the insertion point to the end of the block of text, HOME moves it to the 
beginning of the block, and COMMAND- (CTRL-) UP ARROW or DOWN ARROW moves it up or 
down a paragraph. 

 

 
Get Text from Somewhere Else 
If you want to copy text from a word processor or other source outside of Illustrator, you can copy text 
into your clipboard, and paste it into Illustrator. To do that, you can click and drag with the Type tool to 
create a text box, and then select Edit | Paste. When you do that, the text will be constrained within the 
defined text box. Or, you can simply click on the Artboard with the Type tool and select Edit | Paste. 
With this option, the text in your clipboard will be pasted with paragraph breaks preserved. The first 
option, drawing a text box before you paste, preserves more formatting from the original text. 

To paste text while preserving text formatting, don’t select the Type tool first. Just choose the Selection 
tool and then select Edit | Paste. When you copy text in this way, font, text size, attributes such as 

Note If you first define a text box and then type, your text may not all fit in the text box. I'll show you 
how to resolve this problem by linking text boxes in the section entitled “Link Text Boxes,” in 
Chapter 10. Another option is to resize the text box. You'll learn to do that in Chapter 10 as well.

 
 

Page 2 of 32Part III: Add Type

8/23/2009file://C:\Documents and Settings\afri\Local Settings\Temp\~hh5E37.htm



boldfacing, and text box width will be preserved from the original text.

 

 
Edit Text 
Regardless if you created text in your document (pasting or typing), the type in your document becomes 
a text box after you select another tool. To edit text in an existing text box, you can double-click the text 
with the Selection tool. The Type tool automatically becomes selected, along with the block of text. You 
can select text by clicking and dragging or by holding down SHIFT as you use the navigation keys on 
your keyboard. 

You can use the Edit menu to select Cut, Copy, Paste, or Clear (which is the same as Cut, but the text is 
not saved to the clipboard). 

To view non-printing symbols such as paragraph marks, blank spaces, or forced line breaks (use SHIFT-
ENTER to create these), select Type | Show Hidden Characters. 

Use Illustrator’s Proofing Tools 

Illustrator’s spell checking capability was beefed up a bit for CS, making it easier to edit a custom 
dictionary, among other things. You’ll find that it offers enough basic word processing tools to keep bad 
spellers from making fools of ourselves. You can also convert the case of selected text, and 
automatically generate quotation marks for the beginning and end of quotes. 

To check spelling, it’s not necessary (or worthwhile) to select a text box first. The spelling checker will 
check all the text in your document. Just select Edit | Check Spelling. The Check Spelling dialog box 
will prompt you to correct spellings not found in Illustrator’s dictionary. If you click the Options button 
in the Spelling dialog box, you can elect to find or ignore repeated words and a few other handy 
potential typos you might want to check for. 

To use Illustrator’s smart punctuation tools, select text within a text box by clicking and dragging with 
the Type tool. You’ll then have the option of applying smart punctuation changes to just the selected 
text or to your entire document. Choose Type | Smart Punctuation to open the Smart Punctuation dialog 
box, as shown in Figure 8-3. 

 
 

Tip In earlier versions of Illustrator, the spell check features were found on the Type menu. In CS 
they've been moved to the Edit menu.
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Figure 8-3: Replacing dashes (but not ellipses) with smart characters for selected text only  

Use the available check boxes to make the optional conversions, for instance, from two hyphens (--) to 
an em dash (—), or from standard quotes (") to smart open (“) and close (”) quotes. After you click OK 
in the dialog box, you’ll see a Report dialog box summarizing the changes that were made to your text. 

You can apply the Change Case feature only to selected text. First, select text by clicking and dragging 
with the Type tool, and then select Type | Change Text to open the Change Text dialog box. You can 
convert selected text to UPPERCASE, lowercase, Title Case, or Sentence case. 

The find and replace option in Illustrator works only on an entire open document. Select Edit | Find and 
Replace to open a standard Find and Replace dialog box and either find text or replace text throughout a 
document. Find and replace options allow you to match case, find a whole word, and search 
backwards—or not. New options in Illustrator CS also allow you to check hidden layers and/or check 
locked layers. By default, these options are off, and searching and replacing will not corrupt content on 
hidden or locked layers. The Find and Replace dialog box in Figure 8-4 will skip any text in a locked or 
hidden layer. 

  
Figure 8-4: Skipping text in locked and hidden layers  

 

 
Choose Fonts and Characters 
In Chapter 9, you’ll explore how to assign formatting to text. By default, the last font you selected is the 
font used next time you type. To select a new font for selected type or for text you are about to type, 
choose Type | Font. Illustrator’s list of fonts is cool enough to demonstrate how each font looks, so if 
you don’t have a specific font in mind, you can browse through the options. Some fonts also have 
boldface versions, italic versions, or both—as shown in Figure 8-5.

Tip As always in Illustrator, you can select Edit | Undo if the results are undesirable.

Tip You'll learn to lock and hide layers in Chapter 20. If you find you're bumping into locked layers in a 
project you are working on, or if you want to know right away how to prevent a section of your 
document from being edited, jump up to Chapter 20.
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Figure 8-5: Selecting a boldface font  

You can also use the Type | Size menu to select a font size for selected type or for text you are about to 
type. 

Because you are likely to have dozens if not hundreds of fonts installed on your computer, Illustrator 
provides some tools for quickly finding a font in the Find Font dialog box. Select Type | Find Font to 
display this dialog box and use it to find or replace fonts in your document. If you want to replace a font 
in your document with another one in your document, choose Document in the Replace with Font From 
drop-down list. But if you want to access all the fonts on your system, choose System from the drop-
down list, as shown in Figure 8-6. 

  
Figure 8-6: Viewing a full range of available fonts to replace an existing font  

Many characters in font sets are available from your computer’s keyboard. But, interestingly, most of 
them are not. In the remainder of this chapter, you’ll learn to view, select, and insert additional 
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characters that are useful but not immediately accessible from your keyboard.

Insert Glyphs 

Glyph is a term that encompasses both normal characters (such as A through Z, 1, 2, 3…, and so on) as 
well as non-character symbols such as ©, ®, ™, and so on. Each glyph in traditional font sets has a 
defined three-digit number associated with it. For instance, you can quickly insert the Spanish ñ 
character by entering OPTION-164 (ALT-164) on your keyboard. 

Illustrator makes it much easier to find these glyphs—so you don’t need to memorize keystroke 
combinations of character values. Just choose Type | Glyphs to display the Glyphs palette. The glyphs 
associated with your character set will display in an easy-to-use character map. Double-click on any 
glyph to insert it at the insertion point in your text, as shown in Figure 8-7. 

  
Figure 8-7: Inserting a glyph  

Most typeface sets include hundreds of glyphs in addition to standard characters. Some sets of fonts, 
such as Symbols, Wingdings, and Webdings, include sets of frequently used symbols. For handy 
reference, the entire set of popular Webdings symbols is displayed in Figure 8-8. 

  
Figure 8-8: The Webdings symbol set has frequently used symbols.  

New fonts that utilize OpenType technology have not hundreds but thousands of alternate glyphs. 
You’ll explore those fonts next.  

Work with OpenType 
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One of the more dramatic improvements in Illustrator CS is the ability to utilize OpenType fonts. These 
font sets include as many as thousands of glyphs, including characters and symbols. 

In many cases, this additional character capacity is used to create multilingual font types. These 
multilingual fonts allow you, for example, to design a brochure with text in Korean, English, Dutch, 
Vietnamese, Chinese, and Russian without changing font. 

Beyond providing multilingual font support, OpenType font sets often provide alternate glyph options. 
For example, you might want to use one uppercase M in a font set at the beginning of paragraphs, 
another at the beginning of sentences, and a third version for capitalized words not at the beginning of a 
paragraph or sentence. Or you might take advantage of OpenType alternate glyphs to choose from a set 
of options for symbols such as ™, @, or ®. OpenType fonts also offer a vast array of non-character 
glyphs. 

Create Multilingual Documents with OpenType Fonts 

If you create or import (copy and paste)  

type in multiple languages, you can use an OpenType font to assign uniform font characteristics to all 
your text. Or if you are typing on a western keyboard, you can quickly and (relatively) easily insert some 
Korean or Cyrillic characters. 

In either scenario, you can take advantage of multilingual OpenType font sets. To apply a multilingual 
font to selected text, simply select text (from many language character sets if you wish) and apply a 
multilingual OpenType font. Figure 8-9 shows a single font being applied to text content in English, 
Korean, and Portuguese. 

Tip How much does it add to the aesthetic structure of a multilingual document to use the same font for 
Chinese, English, and Russian characters? Certainly, very few readers will look closely at the 
typeface of languages they don't read. And font differences between characters as disparate as 
English and Korean, Chinese, or Japanese tend to overshadow similarities imbued by using the same 
font for all content. All this is true. But it is still the case that when they display multilingual content 
in a unified font, documents do—on one level or another—take on a more cohesive and coherent 
look. And we can expect that, as the world continues to shrink and multilingual documents become 
even more prevalent, typeface designers will work to develop style attributes that “translate” from 
one character set to another.  
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Figure 8-9: Consistency in appearance can be maintained even in multilingual documents by assigning 
the same OpenType font to all text.  

To (relatively) quickly insert characters from different language character sets, choose Type | Glyphs 
from the menu. Scroll down the Glyphs palette and find your character, as shown in Figure 8-10.  

  
Figure 8-10: Inserting a glyph from the Kozuka Minchu Pro font set  

Use Alternate Glyphs 

OpenType font sets often include many variations for standard (and non-standard) characters. In 
addition to the example at the beginning of the section (using many versions of an uppercase M), you 
can also access other sets of alternative characters such as fractions, scientific notation, or superscript 
characters. 

To access these sets of glyphs, choose Type | Glyphs from the menu. In the Glyphs palette, use the Show 
menu to narrow down the set of characters that is displayed. If you have a character selected, you can 
use the Show menu to display only alternatives to that selected character, as shown in Figure 8-11. 
Double-click on a glyph to insert it at the insertion point in a selected text box. 
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Figure 8-11: Choosing between alternative options for the @ symbol  

 

 

Chapter 9: Format Type 
In Chapter 8 you learned to define text type (font) and size from the Type menu, but the Character, 
Paragraph, and Tabs palettes provide even more control over character and paragraph formatting. 

In addition, many graphical tools such as stroke and fill attributes are applicable to text. You’ll learn 
high-powered text formatting techniques in this chapter. 

Format Characters 
As demonstrated in Chapter 8, you can assign font and size to type from the Type menu, either before or 
after creating the text. To define the font before you type, select Type | Font and select a font from the 
menu. Where supported, additional attributes such as italic or boldface can also be selected here. To 
define type size, select Type | Size and select a font size in points. You can assign size and font to 
existing type by first selecting the text and then using the menu to define font and size. 

The Character palette provides additional options for formatting text. Select Window | Type | Character 
to display the palette, and choose Show Options from the palette menu to display all the formatting 
options. The expanded palette is shown in Figure 9-1.

Tip If the Glyphs palette is displaying characters for a different font set than the one you want, you can 
choose the font you wish to display from the Font drop-down list at the bottom of the Glyphs 
palette. 
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Figure 9-1: Assigning type size in the Character palette  

The following options in the Character palette provide detailed control over how characters are spaced 
horizontally and vertically: 

Font Family  This is the font set, like Arial, Times Roman, Myriad, and so on. 

Font Style  Many font families include boldface, italic, or bold and italic formatting, selected 
here. 

Size  This measures font size in points. You can enter size with another unit of measurement (for 
example, by typing 0.25 inches) and it will be converted, by default, to points. 

Leading  Leading is so named for the olden days when printers used extra shims of lead to 
separate lines of text. Combining 18-point leading with 12-point text, for example, produces 1 1/2 
line spacing, while combining 12-point text with 24-point leading produces the equivalent of 
double-spacing, as shown in Figure 9-2. 

  
Figure 9-2: Double-spacing is created by setting leading at twice the font size.  

Kerning  This option controls spacing between two selected characters. The default value is 0. 
The unit of measurement is the em—about the size of the letter m—and values are defined in units 
of 1/1000th of an em. Positive kerning values add spacing. More frequently, negative kerning is 
used to move characters closer together, as shown in Figure 9-3.
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Figure 9-3: 100 percent kerning pushes the r back next to the B  

Tracking  This selection controls horizontal spacing between characters and words. Measured in 
ems, like kerning, positive tracking values increase space while negative values crunch type 
together. Tracking is illustrated in Figure 9-4. 

  
Figure 9-4: Positive and negative tracking regulate horizontal spacing. Negative tracking is much 
more frequently used and tends to make type more readable.  

The Scale options  Vertical Scale creates taller, thinner text when a value over 100 percent is 
used; it creates shorter, thicker text when a value less than 100 percent is used. Horizontal Scale 
creates shorter, thicker text when a higher value is used. Proportionally, in terms of how text is 
distorted, vertical scaling set to less than 100 percent creates the same shape of text as horizontal 
scaling set to over 100 percent. Both are demonstrated in Figure 9-5.

Tip Kerning is only applied to two characters and can only be assigned when the Type insertion 
cursor is between two characters.
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Figure 9-5: Horizontal and vertical scaling compresses or stretches type  

Baseline Shift  When the baseline shift is positive, it raises any selected character(s) above the 
baseline of the text; negative values move selected characters below the text baseline. This 
treatment is usually reserved for individual superscript or subscript characters. 

Rotation  Character rotation rotates a character or symbol, as illustrated in Figure 9-6. 

  
Figure 9-6: Rotated text is combined here with extreme negative tracking and kerning to push 
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together letters that have been separated by rotation.

Language  Language settings determine what spell check and hyphenation dictionaries are 
applied to selected text. 

 

 
Define Stroke and Fill for Type 
By default, type has a fill color but no stroke color. If you add a visible stroke, type becomes thick and 
sometimes a bit ugly. But you can experiment with different stroke and fill colors and attributes to create 
some interesting text effects. If you assign a stroke but no fill to text, the text appears outlined, as shown 
in Figure 9-7. 

  
Figure 9-7: The effect of outlining on the Impact font is enhanced with a high horizontal scale value (of 
200%).  

You can assign stroke and fill attributes to type just as you would to any path, using the Eyedropper or 
Paint Bucket tool. 

 

 
Format Paragraphs 
The Paragraph palette is where you find tools to align type. Illustrator CS allows you to align paragraph 
type to the right, left, or center. There are also four alignment options for full justification. The full 

Note You set default values for hyphenation language in the Preferences dialog box. To adjust 
them, select Illustrator (Edit) | Preferences | Hyphenation.
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justification feature lets you decide how to align the last line of a full-justified paragraph (left, center, 
right, or full justified). 

The Paragraph palette also defines indenting for a paragraph. You can set indentation from the left, right 
(or both), and also first line indenting. These features work like those in your word processor or desktop 
publishing program, and you’ll pick them up quickly on your own. 

Select Window | Type | Paragraph to view the Paragraph palette. To align or indent text, first select a 
specific paragraph within a text box. You can perform this task easily by triple-clicking on a paragraph 
with the Type tool. With a paragraph selected, you’re ready to apply formatting. 

Align Paragraphs 

With a paragraph selected, use the self-evident alignment buttons in the Paragraph palette to left-, 
center-, or right-align the text. Use the Justify Last Left, Centered, or Right option to justify every line 
but the last in a paragraph with the right and left edges of the text box, and use the Justify All button to 
stretch all of the lines to the left and right borders of the text box, including the last. This last option will 
create very large spacing in short lines of text. 

Full justification often creates awkward looking spacing in the final line of a paragraph. For instance, if 
the line only has a few characters, the spacing required to stretch that text across the entire width of a 
column looks just plain ugly. To help resolve this, Illustrator CS introduces some helpful new alignment 
options. The Justify Last Left, Justify Last Centered, and Justify Last Right options all assign full 
justification except to the last line, which is aligned at the left, center, or right. Figure 9-8 identifies the 
paragraph alignment tools and demonstrates a couple of the new alignment options. 

  
Figure 9-8: Paragraph alignment options allow for justification with left, right, or center alignment (not 
shown) for the last line in a paragraph.  
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The other boxes in the Paragraph palette (except for the last one) define horizontal indentation and 
spacing around paragraphs (in points): 

Indent Left Margin  This box defines how far to indent the entire selected paragraph from the 
left edge of the text box. 

Indent First Line  In this box you can define how far to indent (or outdent) the first line of the 
paragraph in relation to the rest of the paragraph. A positive value indents the first line of the 
paragraph. A negative value outdents the first line of the paragraph, which is useful, for example, 
for numbered or bulleted lists where a number or bullet extends out to the left of the text, as 
shown in Figure 9-9. 

  
Figure 9-9: A positive Indent Left Margin setting is combined with a negative Indent First Line 
value to create the bulleted list paragraph format.  

Indent Right Margin  This box defines the space between the right edge of the text and the right 
edge of the text box. 

Space Before Paragraph  You can use this box to define line spacing before the selected 
paragraph(s). 

Space After Paragraph  In this box you can define line spacing after the selected paragraph(s). 

Hyphenation  This checkbox turns on automatic hyphenation. 

Display Hidden Characters 

As you add more character and paragraph spacing attributes to type, it can get confusing as to where 
spacing is coming from. For instance, did you add double-spacing between paragraphs? Or did you just 
insert an extra paragraph break? You can sort all this out by revealing hidden characters. Do that by 
choosing Type | Show Hidden Characters. If all the hidden characters become confusing, turn it off the 
same way (by deselecting Show Hidden Characters from the Type menu). The space, paragraph, and tab 
characters are identified in Figure 9-10. 
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Figure 9-10: In this text box, hidden characters are displayed to make it easier to manage spacing.  

Set Tabs 

You set tabs and indentation with the Tabs palette (Window | Type | Tabs). Working with tabs in 
Illustrator is similar to working with them in word processors such as Microsoft Word. First you select 
some text, and then you define the tab settings. By default, tabs are set as left-aligned tabs and spaced 
every 0.5 inch. 

Use the Tabs palette to resize tabs. The palette is resizable and can be aligned with selected text by 
clicking the Position Palette Above Text button on the right edge of the tab ruler. 

The Tabs palette has four buttons that allow you to select the type of tab you want to define: left-, 
center-, right-, or decimal-justified. After you select a type of tab (usually left-aligned), either click the 
ruler to define the tab or enter a value in the X box in the palette. 

If you select a Decimal-Justified tab, you can define a character other than the default period character in 
the Align On box. The character you define in that box will be the one used to line up your tabbed 
breaks. 

The Leader box allows you to define a character that will repeat to fill the tab space. Figure 9-11 shows 
text with a left-aligned tab set at 0.25 inches, with a period used as a tab leader. 

  
Figure 9-11: Setting a tab with a leader  

You can also use the movable markers on the left edge of the ruler to define first line (the top marker) or 
paragraph indentation. These options provide a graphical alternative to defining indentation in the 
Paragraph palette.  
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Define Type Styles 
Both characters and paragraphs can have assigned styles. This new feature in Illustrator CS incorporates 
a level of type management heretofore reserved for desktop publishing. 

Character styles might, for example, include font type, font size, font color, rotation, and spacing. A 
single style will save all the attributes applied to a character and allow you to apply those attributes to 
other characters.  

Similarly, paragraph styles can be stored and used to apply a whole set of paragraph formatting 
settings—such as before-and-after spacing, indenting, and alignment. 

Use Character Styles 

The easiest way to create a character style is to apply all the formatting you want to preserve to a 
character. Once you’ve formatted that character, select it. Then choose the Character Styles palette 
(Window | Type | Character Styles). 

With your “model” character selected, and the Character Styles palette open, choose New Character 
Style from the Character Styles palette menu, as shown in Figure 9-12. 

  
Figure 9-12: Defining a character style  

In the Style Name area of the New Character Style dialog box, type a name for your style (spaces and 
special characters like “-” or “!” are fine). Then click OK to preserve the style. 

To apply a named character style, select some characters and click on the named style in the Character 
Styles palette, as shown in Figure 9-13. 

Note The unit of measurement for the Tabs palette is determined by the selected unit in the Preferences 
dialog box. To change this unit, choose Illustrator (Edit) | Preferences | Units & Display 
Performance. Choose a unit of measurement (such as inches) in the General drop-down list to set 
the ruler increments for the Tabs palette. Or, if you wish, you can enter a unit of measurement in 
the tab ruler (such as 0.25 in to enter a value in inches) and it will be converted to the assigned unit 
of measurement (in the case of 0.25 inches, the conversion is to 18 points). 
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Figure 9-13: Applying a character style  

You can revise a style—and apply the new formatting to all characters to which that style was applied. 
Do this by double-clicking on a style in the Character Styles palette. That opens the Character Style 
Options dialog box. Choose from the categories of attributes on the left of the dialog box—General, 
Basic Character Formats, Advanced Character Formats, Character Color, and OpenType Features. 
Within these categories, you’ll find options for changing any formatting applied to the character style. 

After you change formatting options for the selected character style, click OK. The new formatting 
attributes will be applied to all the text associated with the edited character style. 

Use Paragraph Styles 

Just as with character styles, the best way to define a paragraph style is to first format a paragraph with 
attributes such as before-and-after spacing and indentation. Then view the Paragraph Styles palette 
(Window | Type | Paragraph Styles). 

With your paragraph still selected, choose New Paragraph Style from the Paragraph Styles palette menu. 
In the Style Name area of the New Paragraph Style dialog box, enter a name for your style. (As with 
character style names, spaces and special characters work fine). Then click OK to preserve the style. 

To apply a paragraph style, click anywhere in a paragraph and then click on the named style in the 
Paragraph Styles palette. 

As with character styles, you can revise a paragraph style and apply the revised formatting to paragraphs 
to which that style is associated. Double-click on a paragraph style in the Paragraph Styles palette to 
open the Paragraph Style Options dialog box. 

Choose from categories of attributes on the left of the dialog box—the names of these categories (such 
as Tabs or Justification) are helpful, but if you don’t find the formatting feature you want, keep looking. 
Change formatting options for the selected style and click OK. The new formatting attributes will be 
applied to all the paragraphs to which the paragraph style has been attached.  

How to . . . 
Embed Fonts 

The fonts available for assignment in Illustrator depend on the fonts installed on your system. And those 
fonts can be viewed on another computer only if the person looking at your Illustrator file has those 
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same fonts installed on his or her system. That presents a problem when sharing Illustrator files or when 
sending illustrations to a printer. 

If the person viewing your file does not have the fonts you used in your illustration, his or her system 
will substitute a different font, or worse yet, have trouble opening your file. If you've ever opened an 
Illustrator file from a collaborator and been prompted to OK a replacement font, you've seen this process 
in action from the receiving end. You can include (embed) required font types when you save a file, 
making them available to the person who opens that file. 

Most typeface license agreements allow this. If they don't, the typeface is not good for much because 
only you can see the fonts you assign. But you should check on what rights you have to embed fonts if 
you have purchased custom fonts. 

To embed fonts when you save your file, click the Embed All Fonts check box or radio button that 
appears in the Save dialog box for your selected format. The various Save dialog boxes (they differ 
depending on which format you are saving to) also provide options for you to restrict file size by saving 
only those characters (or font subsets) used in your illustration. 

 

 
Convert Text to Outlines 
The safest way to preserve the look of your formatted text is to convert it to outlines—regular Illustrator 
paths that can no longer be edited with Type tools. And with text converted to outlines, you can apply all 
of the effects and path editing techniques available for any other outline. 

The downside of converting text to outlines—and it is a significant downside—is that the text is no 
longer editable, and you cannot use any of the Type tools with it. Therefore, you might want to save 
your text first as type, and then create a copy that you convert to an outline.  

To convert text to an outline, select the text box and choose Type | Create Outlines. The resulting object 
will consist of a group of paths. To move or edit individual letters, ungroup the characters. Converting 
text to outlines is especially useful for text destined for the Web. Because the “text” is actually a graphic 
image, all formatting characteristics are preserved, regardless of which fonts are supported by a viewer’s 
system. 

Figure 9-14 shows characters that have been converted to outlines and that are being manipulated as 
graphical objects—no longer editable as text. 
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Figure 9-14: Outlined text can be edited like any path or shape—but not with Type tools  
 

 

Chapter 10: Flow Text 
Overview 
In Chapter 8 you learned to use Illustrator’s text editing tools, and in Chapter 9 you learned to apply 
pretty intense levels of formatting to text. But the real fun comes next, when you use Illustrator to 
control the flow of type around objects, to fill objects with text, and to create text that runs vertically or 
along the path of an object. 

Flowing text around objects allows detailed control over layout for brochures, white papers, print ads, 
and other text-heavy illustrations. Filling an object with text can be an effective technique for combining 
media and message, as illustrated in Figure 10-1. 

  
Figure 10-1: Text is used both to outline and to fill this illustration.  

In this chapter, you’ll also learn to flow vertical text along a path for effect, as shown in Figure 10-2 .
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Figure 10-2: Flowing vertical text along an arc  

 

 
Link Text Boxes 
If you type more text than will fit in a defined text box, an almost impossibly tiny plus (+) sign appears 
in the lower-right corner of the text box, as shown in Figure 10-3. Overflow text can be continued in 
linked text boxes. 

  
Figure 10-3: The overflow text icon indicates that there is more text than fits in the text box.

Tip The text warp in Figure 10-2 was created by selecting the type, choosing Object | Envelope Distort | 
Make with Warp, and then applying a vertical arc warp.
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The basic routine for linking text boxes is to select both the original (overflowing) text box and another 
shape (any shape), and link the two objects. You can then flow text from one shape into another. The 
following steps will walk you through that process. 

To link two text boxes, follow these steps: 

1. Start by using the Type tool to draw a text box about 1 inch square. After you draw the box, type 
enough text to fill the square. 

2. Keep typing. As you enter more text than the text box can hold, you won’t see the text, but 
Illustrator will store it and it will be available for a linked text box. 

3. After you’ve typed more text than your text box will hold, you’ll notice the tiny plus sign on the 
right side of the text box. 

4. Use any tool to create an additional closed path or shape, as shown in Figure 10-4. 

  
Figure 10-4: Preparing a text box to flow text into  

5. Use the Selection tool to select both the original text box and the new shape. 

6. Select Type | Threaded Text | Create. Text will flow from the text box into the new shape, as 
shown in Figure 10-5. 
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Figure 10-5: Flowing text from one box into another  

You can unlink text boxes by selected them and choosing Type | Threaded Text | Release Selection. Or 
choose Type | Threaded Text | Remove Threading to break the link between the text blocks. The Release 
option can be used when type is flowed into several shapes, and releases only the selected object from 
the flow of type. The Remove Threading option breaks the linkage between shapes, but does not affect 
the type in objects. 

When you link text in multiple objects, the text flows from the earliest created object into the objects 
created later. Or, if you change the stacking order of objects that are linked text boxes (by selecting 
Object | Arrange and choosing a stacking option), text will flow from the top object into lower objects 
within the stacking order. 

 

 
Automatically Lay Out Type 
As mentioned in Chapter 8, Illustrator is slowly adding desktop publishing features as it evolves. Among 
these are features that allow you to automatically wrap text around an image, automatically lay text out 
in columns, and instantly expand a headline to fill the width of a text box. 

None of these features will inspire you to lay out a book in Illustrator—that’s a job for InDesign (or its 
rival, Quark). But Illustrator’s quasi-desktop publishing features can simplify and speed up the process 
of designing a text-heavy poster, flyer, postcard, or brochure. 

Wrap Type 

You can manually wrap text around an object (such as an illustration) by simply creating a text box that 
fits around the object. You can also make this process even easier (if less exact) by using Illustrator’s 

Shortcut You can flow text into a newly created object without using the commands available on the 
Type menu. To do this, click on the plus sign with a selection tool to change the pointer to a 
text icon. Then you can either click on another object to establish the link or click (or drag) 
on the artboard to create a new object to flow text into.

 
 

Page 23 of 32Part III: Add Type

8/23/2009file://C:\Documents and Settings\afri\Local Settings\Temp\~hh5E37.htm



Text Wrapping feature to automatically wrap text around an object. To have text automatically wrapped 
around it, the object must be on top of the text. You can move an object in front of another one by 
selecting the object to move forward and choosing Object | Arrange | Bring to Front. 

Select both the text block and the object around which the text will be wrapped. Then select Object | 
Text Wrap | Make Text Wrap, as shown in Figure 10-6. 

  
Figure 10-6: Preparing to wrap text around an object  

After you apply a text wrap, the Text Wrap Options dialog box appears. The Bumper box allows you to 
define how much space you want to leave between the object and the text. As you set a value, if you 
have checked the Preview check box in the dialog box you can see how the text will flow around the 
object. 

The Invert Wrap check box in the Text Wrap Options dialog box flows text through the wrapped object, 
instead of around the object—which is what you usually want to do. After you tweak your wrap 
settings, click OK to create a text wrap like the one in Figure 10-7.
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Figure 10-7: Automatically wrapped text flows around an object.  

Lay Out with Columns 

Illustrator allows you to lay out type in sequential rows or columns. The most useful application of this 
feature is to format text in columns. To lay out type in a text box in columns, select the text box and 
select Type | Area Type Options. In the Rows box or Columns box, choose a number of columns or 
rows. 

You can also define text flow options using the two buttons at the bottom of the dialog box. If you are 
flowing text from one row to the next, click the button on the right. To flow text from one column to the 
next, you will want to click the one on the left. 

Fit Headlines 

You can quickly and easily expand the width of a headline to fill the entire width of the text box. To do 
this, simply click anywhere in the text of a headline and choose Type | Fit Headline.  

When you apply the Fit Headline feature, you actually increase tracking for your headline, as shown in 
Figure 10-8. 

Tip Automatically wrapped text does not flow around an object with the same accuracy and detail as 
text that flows into a box you design yourself. If automatic wrapping doesn't produce a close enough 
flow, use the technique described in the “Link Text Boxes” section earlier in this chapter to 
customize a precise text flow by drawing a text box with the exact text flow you need. 
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Figure 10-8: The tracking for the expanded headline has been increased to 189 percent, almost doubling 
the spacing between words and characters to fill the text box.  
 

 
Shape Text 
Once you create a text box, you can reshape the text box and the text within it using the path editing 
tools that are explained in Chapter 6. Or you can start with a shape and then either align the text to a 
path or place the text within the path. 

You can reshape any text box using path editing tools such as the Pen, Pencil, or Selection tool. As you 
do, text flows to fill the changed path. If you reshape or resize a text box so that text no longer fits inside 
it, the oh-so-tiny overflow icon (the plus sign) appears on the right edge of the text box. The following 
steps illustrate just one technique for converting a standard rectangular text box into a shaped text box. 

Follow these steps to reshape a text box: 

1. Select an existing rectangular text box, or create one. 

2. Use the Add Anchor Point tool (in the Pen tool tearoff in the Toolbox) to add a few new anchor 
points to the text box. 

3. Use the Convert Anchor Point tool to change anchor points into smooth points. 

4. Manipulate the anchor control points to change the contours of the text box. Figure 10-9 shows 
the outline of a text box being edited to match the shape of the hip-hop illustration so that text will 
flow within the drawing. 
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Figure 10-9: Editing a path to alter the flow of text within it  

By changing the location and curve attributes of the anchors in your text box, you can create text that 
smoothly flows around an adjacent shape.  

When you edit anchor points with the Direct Selection tool to change the path of an object filled with 
text, you change the path but you don’t alter the font size, leading, or other attributes of the text itself. 

You can also interactively resize text as you resize the text box. To resize text as you resize a text box, 
you can use either the Scale tool or the Free Transform tool. Sometimes the Free Transform tool is more 
effective, because it’s a better choice for controlling sizing interactively and it can also be used to rotate 
or even mirror text (for special effects). 

As you resize a text box with the Scale tool or the Free Transform tool, you’ll see the text get wider 
and/or higher depending on how you resize the text box. Text spacing (both line spacing and word and 
letter spacing) adjusts proportionally as you resize the text box. Figure 10-10 shows an example of text 
and the text box being resized to make both longer. 

  
Figure 10-10: Resizing a text box with the Free Transform tool transforms both the size and shape of the 
text box and the size and shape of the text.  

Place Text in a Shape 

Rather than starting with a text box and reshaping it, you can start with an existing drawing and simply 
fill it with text. To fill an existing path with text, you use the Area Type tool in the Type tool tearoff. 
Follow these steps to fill a path with text:

Note To review how to edit paths, refer to the discussion of the Pen tearoff tools in Chapter 6.
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1. Create a path with any drawing tool, or use an existing path. It doesn’t have to be a closed path.

2. Choose the Area Type tool from the Type tool tearoff in the Toolbox. 

3. Click the outline of the path. 

4. Start typing. The text will appear inside the path, as shown in Figure 10-11. 

  
Figure 10-11: Using the Area Type tool to enter type in an object  

Format Area Type Options 

You can define several attributes for Area Type. These will affect type that you create with the Area 
Type tool inside a path. You can set a fixed number of columns, adjust gutter width (space between 
columns), and define how far the text should be offset from the path. 

You get to the Area Type formatting options by selecting Type | Area Type Options from the menu. 
When you do, the Area Type Options dialog box opens. The Width and Height boxes can be used to 
adjust the size of the envelope holding the type. Two-column text, for instance, can be handy for 
flowing text through shapes such as the one in Figure 10-12.

Tip When you use a path as a holder for Area Type, the fill and stroke properties of that object are 
removed, and the only role the shape plays is to form a container for the type. If you want to 
preserve the fill and stroke attributes of a shape and use it as an envelope for Area Type, you 
need to first duplicate the object, and then sacrifice one of the two copies of the shape to serve 
as a type container. 
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Figure 10-12: Two-column text in a text area  

The Insert Spacing box defines the amount of padding between the type and the shape outline. The other 
Offset options (available from the First Baseline and Min) drop-down menus define the type and amount 
of shifting of text within an area. You can use the Preview check box to test these features before 
clicking OK. 

Align Type to a Path 

Aligning type along the outside of a path is similar to aligning it along the inside of a path. You just use 
a different tool: the Path Type tool. 

To attach type to a path, first create the path or use an existing path. Then select the Path Type tool from 
the Type tool tearoff and click the path to which you want to align the text. You can then simply begin 
to type (or paste text from the clipboard). Figure 10-13 shows type being entered on a circle. 

  
Figure 10-13: You can use normal typing techniques to enter type on a selected path.  
Tip Try this to get comfortable flowing text: Use the Selection tool to select a text box with its text. 
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When you attach type to a path, the path stroke changes to no stroke. Illustrator assumes that you created 
the path only to use as a guide for the text, and you don’t want it to be visible. If you want to see the 
path to which the text has been attached, you can select that path again and assign a stroke color and 
other stroke attributes. 

When you select text on a path, diamond-shaped icons define the beginning and end of the text. The 
second of these icons (the one that appears after the text) can be adjusted to enlarge or contract the text 
area. To adjust the location of the text along the path, use the Selection tool to select the I-beam cursor 
that appears at the beginning of the text, and drag along the path to reposition the text, as shown in 
Figure 10-14. 

  
Figure 10-14: Moving text along a path  

Change Path Type Options 

Illustrator CS includes five new options for controlling the flow of text on a path. With Path type 
selected, you can access these options by selecting Type | Type on a Path, and choosing one of the five 
options from the submenu. The Rainbow, Skew, 3-D Ribbon, Stair Step, and Gravity effects are 
illustrated in Figure 10-15. 

When a text box is selected, you can move it (or delete it or copy it). You can select text within a 
text box by double-clicking the box with the Selection tool. This process automatically activates the 
Type tool. To select a portion of the text within a text box, click and drag (or hold down shift while 
using the keyboard cursor keys). Triple-click with the Type tool to select an entire paragraph of text. 
With the Type tool and a text box selected, press command-a (ctrl-a) to select all text in a text box. 
To select either a text box or only the text, use the Direct Selection tool. This tool is useful for 
resizing a text box without changing the size of the type, but it's tricky to do because most text box 
outlines are not stroked (that is, they are invisible). Use Outline view to more easily select the text 
box outline with the Direct Selection tool.

Tip You can click and drag on the center I-beam that appears when the path text is selected to “flip” the 
orientation of the text on the path. 
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Figure 10-15: New path type effects in Illustrator CS  

You can further tweak how text paths appear by opening the Path Type Options dialog box. You can 
access this by first selecting type on a path and then choosing Type | Path Type | Path Type Options 
from the menu.  

The Effect drop-down menu in the Path Type Options dialog box allows you to change which type of 
type path effect to use. The Flip check box flips text both horizontally and vertically. The Align menu 
lets you align text along the Ascender (top), Descender (bottom), Center, or Baseline of text. 

 

 
Create Vertical Type 
The Vertical Type, Vertical Area Type, and Vertical Path Type tools work like their horizontal type 
cousins, except that text is presented vertically, usually from top to bottom. 

For example, if you want to create vertical text, click the Vertical Type tool, click to create an insertion 
point on the artboard, and start typing. Text flows down vertically, as shown in Figure 10-16. After you 

Note The difference between descender alignment and baseline alignment is that descender alignment 
aligns using the bottom of characters, such as the lowercase g or j, that go below the baseline of 
text. 
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adjust to the oddity ofa horizontal text I-beam insertion point, you can enter, paste, and edit text just as if 
it were presented horizontally. 

  
Figure 10-16: Entering vertical type  

You can reverse the orientation of existing text from horizontal to vertical (or vice versa) by selecting 
the type and then choosing Type | Type Orientation and selecting either Horizontal or Vertical. 
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